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ABSTRACT 

 

Recently, there have been more innovative radio frequency identification-based 

technologies developed (RFID). Many fields, including transportation, Several industries, 

including agriculture, inventory management, and health protection, have successfully 

used RFID technology. A radio frequency identification tag, often known as an RFID, is a 

compact device that combines a chip, read/write reader, processor, transmission, and 

administration application. The proposed method aims to track university attendance via 

RFID. The roll-call method is used by many universities to track attendance, which is a 

time and energy waste. It highlights the waste of time and the teaching abilities of teachers. 

Therefore, it is essential to employ competent and efficient contemporary systems since by 

replacing the current attendance system with an RFID one, time and energy waste may be 

reduced. 
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CHAPTER 1 

Introduction 

 
1.1 Introduction 

Numerous locations, including universities for students and other settings like industries 

for staff login and logout times, require to install attendance systems. RFID-based 

attendance systems are utilized in businesses, colleges, and universities. A RFID project's 

main goal is to automatically track student or staff attendance. Utilizing modern 

technologies enhances technique and lessens human error. The recommended strategy is to 

develop an automated method of keeping track of university students' attendance. The 

suggested approach suggests that teaching would consume a significant amount of teacher 

time and resources since the roll call system for students is completed using the class list, 

and it requires time and effort to confirm students' attendance. Therefore, by using effective 

and current technology, time and energy waste may be avoided. As a result, an automated, 

global attendance system might be used. The recommended remedy makes use of a radio 

frequency identification system, a cloud-based storage system, and an automated student 

roll call system. An automated system could offer higher regularity and efficiency 

compared to the traditional method of looking at students. An RFID card reader is included 

in RFID devices, which use wireless microchips for automated item identification [4]. The 

reader is a valuable tool. An RFID reader can wirelessly and line-of-sight identify things 

by reading RFID tags. Describe how the proposed system for identifying and tracking 

attendance uses RFID technology. When RFID cards pass across the read range zone, 

readers placed there are activated. Every classroom at the institution now uses RFID 

technology to encourage the use of the chip roll call system, which records each student's 

attendance. 

1.2 Problem Statement 

One educational institution, University Technology PETRONAS (UTP), uses the manual 

technique of noting attendance, which involves writing names on paper. In general, 

manually documenting student attendance, especially in big classrooms, may be tiresome 

and time-consuming. There are a few modern technologies, such the bar code and 

fingerprint systems, that are used to track students' attendance, but they are all quite 
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expensive and require a lot of maintenance. The usage of a portable computer-assisted 

system can correctly collect and save data, preventing the need for time-consuming 

problems. 

1.3 Motivation 

The rate of education was low in the past due to various obstacles in the society. The rate 

of education of those earlier days has increased day by day now. This rate has only made 

it possible for the education system to go digital. Previously the range of education was 

limited, my education system has been digitally developed at every level to expand that 

education. In the past, the main reason for the declining education rate was to spend time 

outside the school without informing the parents. Over time, the rate of education has 

decreased a lot while staying away from educational institutions. I are interested in making 

this system useful so that our parents can know everything about the child, to prevent them 

from going to other places without informing the parents, to improve the quality of 

education, to ensure the benefits of digital system. 

 

 
1.4 Objectives 

My project aims to design an IoT-Based Student Attendance Management System 

Using RFID which could effectively manage attendance of students. Attendance is marked 

after student identification. For student identification, a student RFID ID Card recognition 

based identification system is used. 

• This project's primary goal is to design and construct of an IoT-Based Student 

Attendance Management System Using RFID. 

• The presence of students present data will be store in database. 

 
• To take several test for future modification. 
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1.5 Methodology 

My methodologies for the project: 

 
•  Coming up with a concept for the design and construction of “IoT-Based Student 

Attendance Management System Using RFID.” developing a block diagram and 

a circuit diagram to identify the components required to build it. 

• Getting all of the parts together and programming the microcontroller to run the 

system. 

• Soldering after placing every component on a PCB board. Afterward, the entire 

block is put together in a board, and ultimately, the system is run and checked. 

 

1.6 Project Outline 

This project book has six chapters in total. The introductory statement, background research 

for the project, rationale, problem statement, research objectives, project methodology, and 

project plan are all included in the first chapter. I evaluate the literature in the second chapter. 

Chapter 3 provides a description of the theoretical model. On this page, The suggested system 

design, which includes a block diagram, circuit diagram, flow chart, project operating 

principle, and a whole project image, will be covered in detail in this part. The evolution of 

hardware and software is covered in the fourth chapter. The findings and a discussion of the 

advantages and applications of my effort are covered in chapter five. Chapter 6 also covers 

the project's conclusion, constraints, and potential future directions. 
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CHAPTER 2 

Literature Review 

 
2.1 Introduction 

The literature review is the main topic of this chapter. Examine some of the works from 

the previous year, such as my project. I may make improvements to the prior project  and 

make it more effective by reading them. 

 

2.2 Literature Review 

With the use of a central database and finger prints, Farzana Akter and her team suggested 

that students participate in the Internet of Things (IoT) [2]. The Smart Classroom Roll 

Caller System (SCRCS) from Ching Hisang Chang enables local display of student 

attendance. [1]. Professors and students at the university Ire given RFID proposals by Majid 

Meghdadi and Ahad Abbaszadeh Azar[3]. Typically, RFID involves three fundamental 

responsibilities. They are the application management system, RFID tags, and RFID 

readers. There are two types of it: active and passive. When installing the system, both the  

frequency that the RFID tag and reader utilize must match. High frequency RFID scanners 

can read high frequency RFID tags that are unable to read the frequency of regular tags. 

Most institutions use high frequency and ultrahigh frequency RFID cards for their students. 

Security, library door entry, parking for motorcycles and cars, and payment are just a few 

uses for RFID cards [1]. In this work, a fictitious roll call system concept that uses cloud 

storage and RFID and IoT technologies to verify each student's ID attendance is provided. 

A conceptual design model is used in university classrooms to verify student attendance 

and overall attendance figures. Each student's student card must be registered. They sign on 

or exit from the RFID sensor board using their card [1]. 

Several related literary works discuss the use of RFID technology to various sectors, 

notably the problem of tracking academic attendance. to access the biometric data on the 

digital passport, writers in [6] created and built a concept of a portable, secure embedded 

reader system. By employing the Global System of Mobile Communications (GSM) 
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network for online holder authentication, the authors tried to address issues with E-

passports' dependability, security, and privacy. Between the identification center and the 

ePassport reader, the GSM network serves as the primary interface. AES is used to encrypt 

data for security while being transferred across the GSM network, safeguarding the 

server's and the e-passport reader's communication. 

The author of [5] evaluated the most recent studies on RFID uses in several industries, with 

an emphasis on supply chain management applications. Additionally, the author created a 

taxonomic framework to categorize the material, allowing for rapid and easy content 

analysis to assist discover topics for additional research. The usage of RFID in an integrated 

circuit (IC) packaging facility to address inventory transaction difficulties was examined 

by authors in [9]. According to his research, RFID significantly enhances the procedures 

for getting water and transacting in inventories, loIring labor costs and human error. In 

[10], An automated attendance management system on both an electronic and mobile 

platform was developed using a stationary matrix AR 400 RFID reader with four 

circulation polarized antennae and a handheld Symbol MC9000-G RFID reader, 

respectively. The attendance management system is available on the digital platform.  

have put in place an automated attendance system based on RFID. VB.net and a database 

Ire used in the development of this attendance system program (Microsoft Access). Each 

student's student ID card is equipped with an RFID tag. In order to link RFID and the 

computer system, a serial connection has been maintained between the computer and RFID 

reader. The entrance to the lecture hall has an RFID reader there. When students enter the 

lecture hall, an RFID reader scans their RFID tags, stores all relevant data (such as entry 

time, name, and other details) in a database through a serial connection, and keeps the 

system running. In contrast to previous systems, this system's administrator may easily 

access all documents using the software interface by pulling data from the database. [4] a 

Ib-based system and RFID technology Ire used to implement an attendance system. For 

recording student attendance and reading a specific student, this system makes use of an 

RFID tag and reader. The reader then establishes a connection with an Arduino 

microcontroller, which transmits the RFID reader response to a Ib server using an Arduino 

shield. Finally, PHP and MySQL are used to register student 
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attendance in the Ib server. By logging into this specific Ib-based program, the system 

administrator may access all of the students' documents. They can also examine the 

students' individual information on LCD monitors. 

2.3 Summary 

I try to do this project by reading the above literature, and i have been able to make my 

project successful by reducing the mistakes of last year's project. 
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CHAPTER 3 

System Description 

 
3.1 Introduction 

In this chapter, I outline my project's block diagram, circuit diagram, flow chart, project 

operating principle, and final project perspective. Blocks Diagram, version 3.3 

 

 
3.2 System Description 

The main processing brain of the system is the Node MCU. Firstly, to run the 

microcontroller AC supply the main voltage through SMPS. Then system will be starting 

its way. When a user scans their RFID card then data will be saved in database.  

 

 

 

 

 

Figure 3.1: System Schematic Design in proteus.
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3.3 Block Diagram 
 

 
 

 

Figure 3.2: Block Diagram of my System 
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3.4 Circuit Diagram 
 

 
 

Figure 3.3: Circuit Diagram of my system. 

 

 

3.5 Working Principle 

This circuit's power supply component uses 230V from the mains supply, which is step-

downed and converted to DC 5V with the aid of an SMPS. The RFID Module is attached 

to the Node MCU, which converses with it through a Serial port UART (Universal 

Asynchronous Transmitter and Receiver). When a student enters an institute then they scan 

their RFID Card and then they entire . At the mean time when they scan their Card with 

RFID Reader sensor then data will be store in data base. This is the main procedure od the 

system. 
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3.6 Complete Project Image 
 

Figure 3.4: Complete Project Image 

 

 

3.7 Summary 

This chapter has covered a number of the most important things in the project. The  main thing 

is block diagram, circuit diagram. 
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CHAPTER 4 

Hardware and Software 

 
 

4.1 Introduction 

This chapter describes the hardware and software components of my project, which will 

increase its visibility and efficacy. 

 

4.2 About Hardware and Software 

In this project I need some hardware and software for run this project smoothly. 

 

• Hardware 

 
1. SMPS 

 
2. Node MCU 

 
3. RFID Module 

 

• Software 

 
1. Arduino IDE 

 
2. Proteus 

 

 

 
4.3 Hardware 

Electronic hardware is made up of linked electronic parts that, when applied to data that 

has been received and locally stored, conduct analog or logic operations to create new data 

that may be produced or stored. Individual chips and circuits to distributed information 

processing systems are all examples of electronic gear. Hierarchies of functional modules 

connected by Ill specified interfaces make up Ill-designed electronic gear. 
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4.3.1 Node MCU 

 
The open-source Node MCU firmware is compatible with open-source prototype board 

designs. The term "Node MCU" combines the terms "Node" and "MCU" (micro- controller 

unit). Technically, "Node MCU" only refers to the firmware; the associated development 

kits are not included. Additionally open source are the firmware and prototype board 

designs. 

 

 

Figure 4.1: Node MCU 

 
The microcode uses the Lua simulated language. The ESP8266 Espressif Non-OS SDK for 

ESP8266 was used to develop the microcode, which is supported by the eLua project. It 

extensively utilizes free software like SPIFFS and lua-cjson. Users should pick the 

components needed for their project and make a microcode specific to their needs because 

of resource limitations. Additionally, initial support for the 32-bit ESP32 has been 

included. A card acting as a dual in-line package (DIP) that includes a USB controller and 

a smaller surface-mounted board holding the MCU and antenna is the prototype equipment 

that is widely utilized. Board prototyping is simple because to the DIP format's selection. 

The design's fundamental support was provided by the ESP-12 module of the ESP8266, 

which is a Wi-Fi SoC paired with a Tensilica Xtensa LX106 core and widely used in IoT 

applications. 

This IoT platform is free source. It has hardware based on the ESP-12 module and firmware 

that runs on the Express if Systems ESP8266 Wi-Fi SoC. Instead of the development kits, 

the firmware is what is often meant when the phrase "Node MCU" is 
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used. The Lua scripting language is used by the firmware. It is constructed using the 

Espress if Non-OS SDK for ESP8266 and is based on the eLua project. Shortly after the 

release of the ESP8266, Node MCU was developed. The ESP8266 started being produced 

by Espress if Systems on December 30, 2013. Widely utilized in Internet of Things 

applications, the ESP8266 is a Wi-Fi SoC combined with a Tensilica Xtensa LX106 core 

(see related projects). 

 

Figure 4.2: Node MCU Pin Out 

 

 
Hong published the initial version of the Node MCU firmware on GitHub on October 13, 

2014, officially debuting Node MCU. The project was expanded to include an open-hardware 

platform two months after developer Huang R submitted the Gerber file for the devkit v0.9 

ESP8266 board. Later on in the same month, Tuan PM made a contribution to the Node MCU 

project and modified the Contiki MQTT client library for the ESP8266 SoC platform. 

Therefore, by using Lua to connect to the MQTT broker, Node MCU was able to handle the 

MQTT IoT protocol. Devsaurus converted the u8glibto Node MCU project on January 30, 

2015, enabling Node MCU to quickly control LCD, Screen, OLED, and even VGA displays. 

This was a significant development. The firmware project's developers abandoned it in the 

summer of 2015, and a bunch of unaffiliated participants took over. With just a few lines 

of Lua code using the Arduino IDE, the Node MCU V3 ESP8266 
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ESP-12E Wi-Fi development board enables you to prototype your Internet of Things 

device.. 

 

Features 

 
1. The voltage of the 3.3V communication interface. 

 
2. One alternative has a built-in PCB antenna. 

 
3. The wireless 802.11 b/g/n standard 

 
4. Wireless LAN at 2.4 GHz with WPA/WPA2 security mode 

 
5. Support the STA, AP, and STA + AP operation modes. 

 
6. A TCP/IP protocol stack that is integrated and can support up to five TCP Client 

connections 

7. D0 through D8 and SD1 through SD3 are used as GPIO, PWM, IIC, and other 

functions with the capacity to operate 15 mA ports. 

8. AD0: One-channel ADC 

 
9. USB-powered, 4.5V to 9V (10VMAX) power input 

 
10. Current: Standby: 200uA, Continuous Transmission: 70mA (200mA MAX). 

 
110-460800bps is the transfer rate. 

 
12. Support data transmission interfaces UART and GPIO 

 
13. Online firmware update (OTA) 

 
14. Flash memory size: 4 Mbytes. 
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4.3.2  Switch Mode Power Supply (SMPS) 

 
An electric power supply that includes a change regulator is referred to as a switched-mode 

power supply (SMPS), also called as a switch power supply, switch-mode power supply, 

switched power supply, or oppressor. Since an SMPS converts the voltage and current 

properties of a DC or AC source before supplying power to hundreds of DC personal 

computers, it does so similarly to other power supplies (often mains power). A switching-

mode supply's pass semiconductor spends far less time in transitions with high dissipation 

and alternates between full-on and full-off states with low dissipation, which saves energy 

compared to a linear power source. 

 

A switched-mode power supply has no power loss. The on-to-off time magnitude 

relationship is altered to adjust voltage (also called duty cycles). 

 

In contrast, a linear power supply controls the output voltage by continually utilizing the 

pass semiconductor's catalytic power. A switched-mode power supply offers the benefit of 

having superior power conversion capabilities. Due to the loIr size and lighter Iight of the 

electrical equipment, switched-mode power supplies may also be significantly smaller and 

lighter than a linear supply. 

 

 
Figure 4.3: Switch Mood Power Supply (SMPS) 
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When change regulators area unit required, linear regulators area unit swapped out for them 

once a better potency, a smaller size, or a lighter Iight area unit required. HoIver, they're 

additional complex; if their change currents aren't rigorously suppressed, they will lead to 

electrical noise problems, and easy styles might not have an genuine power problem 

Selected switched-mode power supplies are categorized based on input and output voltage 

types. The following are the four major groups: 

 

 AC to AC 

 DC to AC 

 DC to DC 

 AC to DC 

 
An isolated AC to DC switched-mode power supply has the following components: 

 
 Input filter and rectifier 

 Transformer 

 An inverter with switching components like MOSFETs 

 Output rectifier and filter 

 Circuit for feedback and control 

 
The switching MOSFET or polar transistors in the inverter use an input DC supply from a 

rectifier or battery to turn on and off the input DC supply at high frequencies bet Ien 20 

KHz and 200 KHz. High-frequency voltage pulses from the inverter are applied to the 

transformer's main winding, and the secondary AC output is rectified and smoothed to 

provide the required DC voltages. A feedback circuit controls the control circuit to adjust 

the duty cycle while keeping track of the output voltage to maintain the output at the proper 

level. 
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Basic working concept of an SMPS 

 
A switching regulator controls the SMPS. A smoothing capacitor's current supply is turned 

on and off in series. The voltage of the capacitor controls how long the series element is 

run. The capacitor continually flips to maintain the required voltage. 

 
Design basics 

 

Fuse and a line filter are initially used to control AC power. A full-wave bridge rectifier is 

then used to fix it. The downstream DC-DC converter is then coupled to the rectified 

voltage after the power factor correction (PFC) pre-regulator (s). Input connections of the 

International Electrotechnical Commission (IEC) type are used by the majority of 

computers and small gadgets. With the exception of select industries like PC and small 

PCI, output connections and pinouts are often left up to the vendor and not specifically 

defined. How input power is transported to the output is governed by the many circuit 

topologies, or layouts, each having specific features, benefits, and modes of operation. 

Transformers are essential to the majority of frequently used topologies because they offer 

isolation, voltage scaling, and a range of output voltages. These topologies include flyback, 

push-pull, half-bridge, and full bridge. Inductive energy transfer is utilized to convert 

electricity in the non-isolated variations instead of a transformer. 

 

 
Benefits of switched-mode power supplies: 

 
 

 An increase in productivity of 68% to 90% 

 Controlled outputs that are constant despite changes in the input supply voltage 

Slim and light-light 

 Flexible technology is also important. 

 substantial power density 

 
Disadvantages: 

 
 

 Causes interference with electromagnetic fields 
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 Circuit design that is difficult and 

 expensive when compared to linear supplies 

 

 
Computers, delicate electronics, battery-operated gadgets, and other equipment that 

requires high efficiency are all powered by switched-mode power sources. Because of its 

superior ability to generate a constant fixed voltage output, linear voltage IC regulators 

have been used in power supply systems for a long time. Linear voltage regulators are 

frequently far more efficient and easier to use than comparable voltage regulator circuits 

made from discrete components like a resistor and a Zener diode, transistors, or even op-

amps. 

 
Switch Mode Power Supply 

 

Figure 4.4: SMPS Circuit Diagram. 

 

 
The most prevalent linear and fixed output voltage regulator types are the 78... positive 

output voltage series and sequence of negative output voltage These two different voltage 

regulators work together to provide an output voltage that is precise, constant, and ranges 

from around 5 volts to about 24 volts for use in many electronic circuits. There are several 

different types of these three-terminal fixed voltage regulators, and each one has a different 

internal voltage regulating and current limiting circuit. I can thus provide a variety of 

alternate power supply rails and outputs, whether single or dual. 
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that are suitable for the majority of electrical circuits and applications. Even linear 

regulators with output voltage that is constantly shifting and drops to a few volts below 

their maximum output to a few volts above zero are available. 

 

The majority of D.C. power supplies consist of a large, heavy step-down mains 

transformer, full- or half-wave diode rectification, a filter circuit to remove ripple content 

and produce a suitable smooth D.C. voltage, and some type of voltage regulator or 

stabilizer circuit, either linear or switching, to ensure proper regulation of the power supply 

output voltage under varying load conditions. A typical D.C power supply may then 

resemble this.: 

 

 

 
Typical DC Power Supply 

 
 

 

 
 

In these typical power supply systems, a dissipative series regulator circuit and a substantial 

mains transformer are both included. Between the input and output, the mains transformer 

also serves as an isolation device. The regulator circuit may employ three-terminal linear 

series regulator or a single Zener diode supply the required output voltage. A linear 

regulator has the advantage of allowing the power supply circuit to control the output 

voltage using only a few feedback resistors, an input capacitor, and an output capacitor. 
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4.3.3 RFID Module 

The two crucial components of an RFID system are a transponder or tag attached to an 

object that has to be identified and a transceiver, also known as an interrogator or 

reader.. 

 

 
Figure 4.5: How RFID works 

 
A reader is made comprised of a radio frequency module and an antenna that generate a 

high frequency electromagnetic field. The tag, on the other hand, is frequently a battery-

free passive device. Instead, it features a CPU for processing and storing data together with 

an antenna for receiving and delivering signals. 

To read the data encoded on a tag, a Reader must be placed close by (does not have to be 

in the reader's direct line of sight). Electrons travel through the antenna of a tag and power 

the chip as a result of the reader's electromagnetic field. 

A fresh radio signal is then sent by the powered chip within the tag in response, conveying 

the previously stored data back to the reader. Backscatter is what's happening. The data is 

sent to a computer or microcontroller when the reader detects and analyses the backscatter 

or change in the electromagnetic/RF wave. 

My RDM6300 RFID 125KHz card reader mini-module is made to read data from read- 

only tags and read/write cards that are compatible with 125KHz cards. It may be used in 

systems for production control, personal identity, access control, anti-forgery, and home 

and office security, among other things. 
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Figure 4.6: RDM 6300 RFID Module 
 

Features: 
 

• Assistance with external antenna 

• Up to 50mm maximum effective distance 

• Less than 100 ms for decoding 

• Interface Uart 

• Support read-only or read/write tags that are EM4100 compliant. 

• Tiny outline pattern 

 

4.3.4  Capacitor 

 
An electric field forms across the dielectric when there is a potential difference across the 

conductors (such as when a capacitor is connected across a battery). This results in the 

accumulation of positive charge (+Q) on one plate and negative charge (-Q) on the other 

plate. If a capacitor is coupled with a battery for a sufficient amount of time, no current can 

flow through it. A displacement current can, hoIver, flow if an accelerating or alternating 

voltage is supplied across the capacitor's leads. 
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Figure 4.7: Capacitor 

 
An perfect capacitor's capacitance is described by a single constant value. The electric 

charge (Q) on each conductor is compared to the potential difference to calculate 

capacitance (V). One coulomb per volt (1 C/V) is equal to one farad (F), is the SI unit for 

capacitance. The typical capacitance ranges from around 1 pF (1012 F) to approximately 1 

mF (103 F). When the space between conductors is less and the surface area of the 

conductors is bigger, the capacitance increases. 

 
4.3.5  Resistor 

A resistor is a two-terminal electrical component that is passive. used in circuits to 

implement electrical resistance. In addition to reducing current flow, resistors can 

occasionally loIr voltage levels inside circuits. As with thermostats, visitors, trimmers, 

photo resistors, hamsters, and potentiometers, resistors can have fixed or variable 

resistances. The voltage across a resistor's terminals directly correlates to the current 

flowing through the resistor. Ohm's law is a representation of this connection. 
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Figure 4.8: Resistor 

 

Theory of operation 

The connection described by Ohm's law controls how an ideal resistance behaves: 

V = I.R 

Ohm's law states that resistance acts as the constant of proportionality in the relationship 

between the voltage (V) between the current and a resistor (I) (R). 

The equivalent formulation of Ohm's law is: 

I = V/R 

According to this equation, the resistance (R) is inversely proportional to the voltage (V) 

and the current (I) is proportional to both (R). This is immediately applied in real-world 

calculations. For example, if a 300-ohm resistor was placed across the terminals of a 12-

volt battery, it would conduct a current of 12 / 300 = 0.04 amperes. 

 
4.4 Software 

Software is a set of instructions, information, or computer programs that are used to 

operate equipment and perform certain tasks. Hardware, which refers to a computer's 

exterior components, is the polar opposite of it.. 

4.4.1 Arduino IDE 

 
The Arduino code IDE will be used to program the Arduino Nano digital microcontroller. 

Additional than Arduino, no other code has to be installed. To begin, choose "Arduino 

Nano" from the Tools, Board menu (the microcontroller on my board). USA may upload 

fresh code without the need for an additional hardware computer programmer since the 

boot loader of the ATmega328 IC used in the Arduino Nano is preprogrammed. 
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The original STK500 protocol is utilized for communication (reference, C header files). 

The boot loader can be skipped, and the microcontroller can be programmed directly via 

the ICSP (In Circuit Serial Programming) header. The ATmega16U2 (or 8U2 in the rev1 

and rev2 boards) microcode ASCII text file is available. The ATmega16U2/8U2 comes 

with a DFU boot loader, which will be made accessible by: 

In order to reset the 8U2 on Rev1 boards, I'm going to connect the solder jumper on the 

back of the board, next to the map of Italy. The 8U2/16U2 HWB line is pulled to ground 

on Rev2 and subsequent boards by an electrical mechanism, making it simpler to enter 

DFU mode. 

One of the foremost fashionable digital microcontrollers is that the Arduino Nano, which 

incorporates a spread of communication choices with a pc, a different Arduino or other 

microcontrollers. Using a 5 volt UART TTL for serial connection provided by the 

ATmega328 and is offered on digital pins zero - (RX) for information reception and pin 

no. one (TX) for information transmission. The ATmega16U2 on the board, which the pc 

code interprets as a virtual com port, routes this serial connection over USB. Since the 

'16U2 microcode makes use of the official USB COM drivers, there is no need for an extra 

driver. A.in files, hoIver, are crucial on Windows. Simple data will be sent to employing a 

serial monitor that may be found in the Arduino code, which was obtained from the 

Arduino board. 

The board's RX and American status LEDs may blink when data is sent to the computer 

using the USB-to-serial chip and USB association (but not for serial communication on 

pins zero and one). Any digital pin of the Nano may now support serial communication 

thanks to the code's serial repository. Additionally, I2C (TWI) and SPI are supported for 

communication by the ATmega328. To make using the I2C bus easier, the Arduino code 

has a Wire library. Ideas are written pieces of C or C++ code that are used to develop 

Arduino applications. The Wildebeest tool chain and AVR work are used by the Arduino 

IDE to generate and transfer programs, so. 
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When data is delivered to the computer using the USB-to-serial chip and USB association, 

the board's RX and American status LEDs may flash (but not for serial communication on 

pins zero and one). Serial communication is possible on any digital pin of the Nano thanks 

to the code Serial library. Additionally, I2C (TWI) and SPI are supported for 

communication by the ATmega328. To make using the I2C bus easier, the Arduino code 

utilizes the Wire library.The code wont to produce Arduino applications, referred to as 

ideas, is written in C or C++. The wildebeest tool chain and AVR work ar utilized by the 

Arduino IDE to compile programs and transfer programs, consequently. AVR Studio or the 

neIr Atmel Studio, Atmel's development surroundings, may additionally be wont to produce 

code for the Arduino platform as a result of it makes use of Atmel microcontrollers. 

 

 
Figure 4.9: Arduino Software Interface IDE 

 
There is also the Arduino Software (IDE), sometimes known as the Arduino Integrated 

Development Environment. It has a text editor for writing code, many menus, a toolbar with 

buttons for frequently used tasks, a message box, and a text terminal. In order to upload 

programs and connect with the Genuine hardware, it establishes a link with it. 
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Writing Sketches 

 
In order to create computer programs known as sketches, one uses the Arduino software 

(IDE). These graphics are created in a text editor, and then they are saved as files with 

the.ino extension. In the editor, there are tools for text substitution and text searching. When 

saving and exporting, the message field provides information about problems and feedback. 

The terminal shows text generated by the Arduino Software (IDE), as Ill as supplementary 

information and detailed error warnings. The configured board and serial port are visible in 

the window's bottom right corner. You can create, save, and save drawings using the toolbar 

buttons, as Ill as examine the serial monitor, validate and upload programs, and more.. 

 
Sketchbook 

 
The Arduino Software (IDE) uses the concept of a sketchbook as a standard area to keep 

your programs (or sketches). You may access the sketches in your sketchbook by choosing 

File > Sketchbook from the menu or by clicking the Open button on the toolbar. The 

Arduino application will automatically create a directory for your sketchbook when you 

first launch it. The Preferences window's placement of the sketchbook can be checked or 

changed. As of version 1.0, files are saved with the a.ino file extension. For earlier 

generations, use the.pde extension. Versions 1.0 and later still allow you to open.pde named 

files, but the application will change the extension to.ino automatically. 

Tabs, Multiple Files, and Compilation 

 
Permits handling of sketches that combine many files (each of which appears in its own 

tab). These can be header files, C files, C++ files, or ordinary Arduino code files (no evident 

extension) (.h). 

Uploading 

 

You must choose the appropriate options from the Tools > Board and Tools > Port menus 

before submitting your picture. Below is a description of the boards. The serial port on a 

Mac will likely be something like /dev/tty.usbmodem241, /dev/tty.usbserial-1B1, or 

/dev/tty.USA19QW1b1P1.1 for an Uno, Mega2560, or Leonardo (for a serial board 

connected with a Keyspan USB-to-Serial adapter). To distinguish between them, check for 
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USB serial device in the Windows Device Manager's ports area. Most likely, it's COM1 or 

COM2.(for a serial board) or on Windows, COM4, COM5, COM7, or higher (for a USB 

board). It should be /dev/ttyACMx, /dev/ttyUSBx, or something similar on Linux.. Once 

you've chosen the correct serial port and board, either pick Upload from the Sketch menu 

or click the upload icon in the toolbar. The upload will start when the current Arduino 

boards have been automatically reset. You must push the reset button on earlier boards 

(pre-Diecimila) that lack auto-reset right before beginning the upload. As the sketch is 

uploaded, the RX and TX LEDs on the majority of boards will begin to flicker. When the 

upload is finished, the Arduino Software (IDE) will either show a message or an error. 

Libraries 

 
Libraries add any practicality to sketches, like addressing hardware or manipulating 

information. To use a library in a very sketch, select it from the Drawing > Import Library 

menu. This may build the library next to your drawing and add one or more #include 

declarations to the top of it. as a result of libraries square measure uploaded to the board at 

the side of your sketch, they take up extra space. merely take away the #include directives 

from the start of your code if a sketch now not needs a library. The reference contains an 

inventory of libraries. The Arduino program includes some libraries. Others will be derived 

from varied of sources, as Ill as the Library Manager. you'll be able to import a library from 

a zipper file Associate in Nursingd use it in an open sketch beginning with version one.0.5 

of the IDE. Follow these steps to put in a third-party library. 

Third-Party Hardware 

 
You may add support for third-party hardware to your sketchbook directory's hardware 

directory. Board definitions, core libraries, bootloaders, and programmer definitions are 

examples of platforms that may be placed there and display in the board menu. Create the 

hardware directory before installing, and then unzip the third-party platform into a separate 

sub-directory. (If you name the sub-directory "Arduino," the Arduino platform that is 

already built-in will be overridden.) Simply deleting its directory will remove it. Consult 

the 3rd party hardware for the Arduino IDE 1.5 standard for further information  
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      on how to create packages for third-party hardware. 

 
Serial Monitor 

 
This shows serial data transmitted through USB or a serial port from an Arduino or 

Genuine board. Enter the text and hit the "send" button or enter to send it to the board. 

From the drop-down option, select the baud rate that matches the rate provided to Serial. 

putting the sketch first Whenever you connect to the serial monitor on Windows, Mac, or 

Linux, the board will reset (it will execute ymy sketch again). Please be aware that the 

Serial Monitor does not support the usage of control characters. If your project requires 

total control over serial communication using control characters, you may utilize an 

external terminal application by connecting it to the COM port allocated to your Arduino 

board. 

4.4.2  Proteus Software 

A proprietary tool set used largely The Proteus style Suite is used for electrical style 

automation. For the purpose of obtaining schematics and natural philosophy prints for the 

fabrication of pcbs, the package is mostly utilized by engineers and technicians who 

operate in the natural philosophy style. 
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Figure 4.10: Proteus Software Interface 

 
 

The company's chairman, John Jameson, developed the first iteration of what is now the 

Proteus Design Suite in 1988 under the codename PC-B for DOS. In 1990, the practicality 

of A change to the Windows environment folloId the intercalary use of Schematic 

Capture. In 1996, Proteus ran its first enclosed mixed mode SPICE simulation, and in 

1998, it ran a simulation of a microcontroller. In 2002, shape- based automobile routing 

became mandatory, and in 2006, 3D board visualization was made available. MCAD 

import/export was intercalary in 2015, and a specific IDE for simulation was intercalary 

in 2011. Support for fast-paced style was intercalary in 2017. Products available are 

typically released every two years, whereas maintenance-based service packs are offered 

to national customers. 

4.5 Summary 

I Ire able to complete the project using the above hardware and software and the 

details of hardware and software in this chapter will help to know about them.
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CHAPTER 5 

Result and Discussion 

 
5.1 Introduction 

This chapter will cover the crucial aspect of my project. Here is a thorough explanation 

of my project's outcomes, benefits, applications, and conversations. 

 
5.2 Result 

It's time to discuss the outcomes now. The following things may occur after writing my 

commands using the Arduino IDE: 

• When the system is powered on then it will able to do perform as I expect. 

• Then student scan their RFID card, then it will take attendance. 

• If the RFID card is authorized then it takes attendance and blink green led, 

otherwise it will not take attendance, 

• All this data will show in database. 

 
5.3 Advantages 

There are many advantages of my project because of its accuracy. Some of the 

advantages are pointed out below: 

• High Security. 

 
• The presence of students is increasing. 

 
• Count As an attendance. 

 
• Data will be store in data base. 

 
5.4 Applications 

  

This project's applications in the modern and practical world are numerous, and some of 

them are listed below: 

• School 

• College 

• University 
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• Hospital 
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CHAPTER 6 

Conclusion 

 
6.1 Conclusion 

This project's primary objective was to develop an attendance management system using 

an RFID identification device. Management of attendance is particularly beneficial for 

saving instructors' and students' important time, paper, and producing reports as needed. 

This project provided a platform for automating and conducting online attendance 

tracking. The deployment of the RFID Card Identification System, which is used for 

student identifying, is quicker than that of other identification systems. 

 

6.2 Future Scope of Work 

As I have already discussed about the advantages and application of my project so 

definitely there’s room for improvement and thus, I have lots of future scope of work 

available to us for this project. Some of these are listed below: 

• It can be later implemented for the teaching staff. 

• In future I will add voice confirmation system. 
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